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.I: How to use this Guide

Using the Guide

MicroLogPRO is a compact 10-bit data logger used to

monitor the temperature and humidity of perishable goods

and controlled environments. The MicroLogPRO comes in

two models:

e EC750 with built-in temperature and humidity
sensors

e EC700 with temperature sensor only

It can also be connected to external sensors in order to
monitor additional parameters, and can be mounted onto a
cradle for use with the Sound Alarm feature as well as the
wireless Daily Download tool.



How to use this Guide -I:

MicroLog Plus is a sophisticated data logging system, which
can remotely monitor up to 200 MicroLogPROs
simultaneously.

Chapter 1 of this user guide details the operation procedures
for MicroLogPRO as a standalone device, as well as
instruction on how to work with its software program,
MicroLab.

If you are using the wireless MicroLog Plus system, then
read Chapter 2, which details the setup and operation of the
wireless MicroLog Plus system.

Chapter 3 explains how to run MicroLogPRO connected to a
cradle. Chapter 4 covers connecting your MicroLogPRO to a
receiver. Chapter 5 explains the use of external antenna
while Chapter 6 details connecting the MicroLogPRO to
external sensors.

2



.I: How to use this Guide

Compliance with FDA Title 21 CFR Part 11

To achieve compliance with FDA Title 21 CFR Part 11, use
Fourier Systems’ software packages: MicroLab or MicroLab
Plus together with DatPass. The DatPass software is Fourier
Systems’ administration software. Among other features, it
defines the users that can log onto the MicroLab/MicroLab
Plus software, their passwords and the digital signatures the
users are permitted to sign data within electronic records
(files). DatPass also maintains an audit trail to keep track of
all action performed within the system. The system is
secured with a serial port dongle, without which the MicroLab
and DatPass software packages will not operate.
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.F MicroLogPRO  Chapter 1

1.1. Overview

MicroLogPRO can be used as a standalone device to
monitor temperature and humidity levels. All viewing,
exporting and printing of the data obtained is done with just
two keys. MicroLogPRO continuously displays the most
recent recordings, along with the maximum and minimum
values for a selected time interval. Users can also define
minimum and maximum alarm levels for a specific shipment,
and the display screen will show alarm icons if either level is
breached.

(Instructions for using the Sound Alarm feature can be found
in section 3.1.1).

The data stored by MicroLogPRO can be downloaded to any
computer for further viewing and analysis using the MicroLab
software, and can be exported to an Excel spreadsheet.



Chapter 1 MicroLogPRO -I:

The data can also be easily transmitted to an infrared printer.

1.2. Getting Started

In order to save battery life, MicroLogPRO is shipped in Stop
Mode. This means that before you can start recording, you
must first connect MicroLogPRO to the PC and set it up with
the accompanying MicroLab software. To set up
MicroLogPRO with the MicroLab software, refer to section
1.4.

Once MicroLogPRO receives the setup command, it begins
logging the data immediately or waits for a predefined time to
start logging.
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1.3. Working with MicroLogPRO

1.3.1. Data Displays

Current Data

When MicroLogPRO is recording, the data from the sensors
is alternately displayed. The data obtained from external
sensors is displayed with a small EXT icon.

When MicroLogPRO stores the data, the LCD display briefly
changes to a four dash (- - - -) symbol.

Minimum and Maximum Values

You can display minimum and maximum values, ranging
from the last
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1 - 24 hours and from the last 1 - 30 days, by using
MicroLogPRO'’s left and right buttons:

Viewing Min. and Max Values in the last 1-24 Hours

1. Select a time period
by pressing the right
button on the
MicroLogPRO. The
LCD will begin
displaying the hour
number, ranging from
1 to 24 hours. Once
you've reached the
desired time period,
release the right




MicroLogPRO Chapter 1

button.

Once you've released the right button, MicroLogPRO
will display the Min and Max values logged by the
sensors during the selected time period.

Once the button is released, MicroLogPRO will also
send an IR signal of a predefined data options. To
receive a printout of this data, simply point the
MicroLogPRO to the IR printer (HP portable printer —
model No. 82240B).
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MicroLogPRO
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Viewing Min. and Max Values for the last 1-30 Days

Select a time period
by pressing the left
button on the
MicroLogPRO. The
LCD will display the
day number, ranging
from 1 to 30 days.
Once you've reached
the desired time
period, release the
left button.
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2. Once the left button is released, MicroLogPRO will
display the Min and Max values of the sensors for the
selected time period.

3. Once the left button is released, MicroLogPRO will also
send an IR signal of a predefined data options. To
receive a printout of this data, simply point the
MicroLogPRO to the IR printer (HP portable printer —
model No. 82240B).

Status Messages

When both the left and right buttons are pressed
simultaneously, the MicroLogPRO LCD will display
MicroLogPRO’s current working mode and version.

n
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After releasing these buttons, MicroLogPRO will display its
internal software version (if the letter H appears next to the
version number, this means that this model includes a built-in
humidity sensor as well as a temperature sensor)

The status messages include:

Mn —Run

12
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— Cyclic Run
— Timer Run
— Stop Mode

— Downloading data to a PC

13
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PUSH
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MicroLogPRO

— Push to Run

— Sending data to an IR printer
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1.3.2. Working Modes

MicroLogPRO is always set in one of 5 possible modes:
Stop — MicroLogPRO is idle and is not recording.

Run — MicroLogPRO is recording data. It will stop recording
automatically when its memory has reached full capacity
(52,000 samples with one sensor).

Cyclic Run — Similar to Run mode, but MicroLogPRO will
record over the old data when the memory is full, beginning
with the earliest data recording.

Timer Run — MicroLogPRO can be configured to start
recording at a predetermined time. When MicroLogPRO is
set for such a run, its status is set to Timer Run.

Push to Run — MicroLogPRO will only begin logging data
when the user pushes either the left or right buttons.

15
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1.3.3. Alarm Levels

MicroLogPRO displays an alarm notification whenever any
alarm level is exceeded.

AL-L — A sensor’s reading is lower than its low alarm level.
AL-H — A sensor’s reading is higher than its high alarm level.
The alarm notification remains until the next time you view
Min/Max values or download data to a PC.

To learn how to set alarm levels, refer to page 58.

16



.I: MicroLogPRO Chapter 1

1.3.4. MicroLogPRO’s Connections

Note: MicroLogPRO ships with a rubber plug that covers the
rear socket. The plug protects the socket from moisture.
Unless you are using the socket, leave the plug in.

Connecting MicroLogPRO to a Computer

For this you will need a serial communication cable (catalog
number DT058).

oy~ The serial communication cable
£ 1 ends with a type D 9-pin female
4 l plug. Plug this in to any free COM

3 port on your computer.

17
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The other end of the
serial communication
cable ends with a small
black flat plug. Plug this
end into the socket at the
back of the
MicroLogPRO.

Note that the socket has
three pins, with one
further away from the
other two. Take care to
plug the <cable in
correctly.

18

Figure 1: Connecting
MicroLogPRO



.I: MicroLogPRO Chapter 1

Note: You can also connect to the PC via the Cradle (refer to
page 199).

Connecting MicroLogPRO to an External
Sensor

Use the same PC connection socket to connect to an
external sensor (see Figure 1).

Note that the socket has three pins, with one further away
from the other two (Figure 1). Take care to plug the cable in
correctly.

Note: You can also connect the external sensor to the
Cradle (refer to page 199).

19
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1.3.5. Sending Data to an Infrared Printer

MicroLogPRO can send data to an infrared printer. There are
two formats of data sending. In one format, MicroLogPRO
sends the minimum and maximum values of a selected time
period up to the last 30 days. The second format enables
you to send all data up to 80 rows of data. Programming
MicroLogPRO to the desired mode is done via MicroLab
software (refer to page 78).

Sending Min/Max Values

1. Select the time period as in viewing the min/max values
(refer to page 7)

2. Release the button.

3. Point MicroLogPRO to the IR printer (HP portable printer
— model No. 82240B).

20



.F MicroLogPRO  Chapter 1

The printout includes MicroLogPRO’s serial number and
comment, alarm levels, the minimum and maximum values
for each sensor and the time duration of any breaching of the
alarm levels.

Sending all of the Data

1. Point MicroLogPRO to the IR printer.
2. Push any button on the MicroLogPRO logger.

The printout includes MicroLogPRO’s serial number and
comment, alarm levels, and a table of pre defined number of
rows including time column, sensors readings columns and a
column with an asterisk for each time any of the alarm levels
was exceeded.

21
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1.3.6. Battery Level

MicroLogPRO displays a battery level indicator at the top
right corner of the LCD screen — a battery icon with bars in it.
Three bars indicate a full battery and an empty icon indicates
a low battery that needs replacing.

The MicroLogPRO battery’s maximum lifespan is
approximately 2 years. This long battery life is achieved by
MicroLogPRO putting itself to sleep between recordings, or
after 4 minutes goes by without communication with the
computer. While in sleep mode, the data logger consumes a
minimal amount of power.

MicroLogPRO wakes up every second for a few micro-
seconds in order to check if one of the buttons has been
pressed or if there is an incoming message from the

22
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computer. For this reason, you must press and hold a button
for at least two seconds before a status message appears.

If you use high sampling rates, the MicroLogPRO battery’s
lifespan will be considerably shorter (refer to Figure 2 below).

23
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Figure 2: MicroLogPRO battery life
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Note: The figures on the graph refer to MicroLogPRO usage
without daily download and without viewing min/max values
on MicroLogPRO'’s display.

1.3.7. Replacing the Battery

Warning: The back cover of the MicroLogPRO contains a
special compartment for the built-in sensors, which are very
fragile. When removing or replacing the cover, be careful not
to harm the sensors.

25
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Sensors’ compartment Temperature and humidity sensors

Figure 3: Replacing the battery

| Note: The MicroLogPRO uses a 1/2AA 3.6V lithium battery.

26
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Unfasten the four screws on the back of the
MicroLogPRO.

Carefully remove the back cover.

Replace the battery, and be sure to insert the new
battery into the correct corresponding polarities (look for
the " symbol next to the positive terminal).

Carefully reposition the electronic board on
MicroLogPRQO’s back cover and make sure that the
humidity sensor is placed in its compartment.

Refasten the four screws on the back of the
MicroLogPRO.

27
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1.4. Working with the MicroLab
Software

1.4.1. |Installation

System Requirements

To work with MicroLab, your system should be equipped with
the following:

Software

e  Windows 95 or later (Windows 95 will not support USB).

e Internet Explorer 4.0 or later (you can install Internet
Explorer 5 when you install MicroLab Plus, as it ships
with the product).

28



.I: MicroLogPRO Chapter 1

Hardware

e  Pentium 300MHz or higher

e 32 MB RAM (64 MB recommended)

e 5 MB available disk space for the MicroLab application

Installing the Software

1. Insert the CD into your CD drive.

2. The installation will start automatically. Once the
process begins, follow the on-screen instructions.

3. If auto run is not working, open the CD drive folder and
double-click the setup icon, then follow the on-screen
instructions.

To uninstall the software: From the Start menu select

Settings > Control Panel, and use the Add/Remove

Programs tool to remove the MicroLab application.

29
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To install the USB driver (optional for cradle

communication):

1. Insert the CD into your CD drive. If Installation begins
automatically (and you have already installed MicroLab),
click Cancel to stop installation.

2. Connect the Cradle to a USB port on your PC. Windows
will automatically detect the new device and open the
Add New Hardware Wizard.

3. Select Specify the location of the driver, and then
click Next.

4. Select Search for the best driver for your device,
then check the Removable Media checkbox, and click
Next.

Windows will automatically detect and install the necessary

software.

30
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1.4.2. Overview

The MicroLab software was designed to allow for the
programming of the desired data recording specifications for
MicroLogPRO, to enable the downloading of recorded data
to a PC, and to store, view and analyze the data.

The Logger menu handles all communication between the
PC and MicroLogPRO, such as programming the desired
recording mode, starting or stopping data recording, as well
as downloading the data.

The View menu controls the various data display options.
Data can be viewed in graph format, in table format, or in
both. The Data Map is a separate pane that displays a list of
the open data sets. It can also be used to quickly navigate
through the data sets.

31
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The Graph menu contains all the commands needed to
format and edit the graph.

The most common tasks and commands are available as
buttons on the main toolbar and on the graph toolbar.

1.4.3. Getting Started

Downloading Data

1. Connect MicroLogPRO to the PC.
2. Open the MicroLab software.

3. Click Download on the main toolbar.

Once the downloading has been completed, the data will be
displayed both in the graph and in the table, and a new data
icon will be added to the Data Map.

32
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You can now connect a different MicroLogPRO to the PC
and download its data. The number of downloads is limited
only by the memory available on the computer.

Use the Data Map (refer to page 40) to navigate between the
different data sets.

Saving Data

To save the displayed data, click Save E on the main
toolbar. The data currently displayed by the graph will be
saved in the MicroLogPRO Data folder:

C:\Program Files\Fourier
Systems\MicroLogPRO\WMicroLogPRO Data

33
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The data file name consists of the MicroLogPRO name
(Comment, refer to page 59) and of the time and date at
which it was saved.

To save data in a different location or under a different name,

use the Save as... command from the File menu:

1. Select Save as... from the File menu.

2. Enter a new name in the File name box.

3. To save the data in a different folder, select a drive
and/or folder from the Save in dialog box.

4. Click Save.

If you've downloaded data from more than one
MicroLogPRO and you want to save all the data sets, select
Save all from the File menu.

If you are using the Daily Download option, data will be
saved automatically.

34
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Note: If you want to remove unwanted data before saving,
apply the crop tool (refer to page 48).

Opening Files

1. Click Open G on the main toolbar.

2. To open a document that was saved in a different folder,
select a drive and/or folder in the Look in dialog box.

3. Double-click the file you want to open.

Displaying Properties

You can change the way numbers and dates will be

displayed on screen.

1. Click File on the main menu, and then click Display
properties.

35



Chapter 1 MicroLogPRO -I:

2. Under Decimal place settings, enter the number of
decimal places you want to display (enter a number
between 0 and 4) for each sensor.

3. Under the Date format settings, select the desired
format option.

4. Click OK.

Printing a Graph

1. Click Print ﬁ on the main toolbar to open the Print
Options dialog box.

Click the Graph option.

Click Print to open the Print dialog box.

Click OK.

roN

36



.F MicroLogPRO  Chapter 1

Printing a Table

The displayed data can also be printed as a table. The table
will only include data from sensors that are currently
represented on the graph (to learn how to add or remove
data sets from the graph, refer to page 40) as well as the
MicroLogPRO name, serial number and the alarm level
setup. Data that exceeds any of the alarm levels will be
highlighted by arrows.

1. Click Print on the main toolbar to open the Print
Options dialog box.

2. Click the Table option.

3. If you want to print only part of the data, uncheck the
check box and select the desired time and date in the
From and To boxes.

37
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4. Click Print to open the Print dialog box and click OK.

1.4.4. Viewing the Data

Display Options

MicroLab’s main window consists of three parts: the graph,
the table and the Data Map. You can display all three parts
simultaneously (the default view) or any combination of
them.

If you are using the Daily Download option, you can also
display a daily status window (refer to page 86).

38
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Graph

Click Graph l% to display or remove the graph. The graph
displays the data sets plotted vs. time. The graph usually
displays all the data sets of a given MicroLogPRO, but you
can use the Data Map to remove one or more of the sets
from the graph (refer to page 40).

In order to keep the graph clear and simple, only two Y-axes
can be shown on the graph simultaneously. If there are three
curves in the graph, one of the Y-axes will be hidden. To
make this axis visible, select the corresponding plot with the
cursor (refer to page 42).

You can identify the Y-axis by its color, which matches the
plot color.
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Table

Click Table % to display or remove the table.
The data in the table always matches the data that is
currently displayed on the graph.

Data Map

Click Data Map E to display or remove the Data Map.

The Data Map is a separate window that displays the list of
data sets that were downloaded or opened in the current
session. Use the Data Map to navigate through the available
plots and to keep track of the data that is displayed in the
graph and/or table windows.
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When you double-click on a MicroLogPRO icon @ in the
Data Map, MicroLab jumps to the corresponding data and
displays it in the graph and table windows. It also expands
the Data Map to show the individual sensors included with
the selected MicroLogPRO.

A graph icon indicates that the data set is currently being
displayed. Double-click on the icon to clear the data set from
the display.

An empty icon indicates that the data set is not being
displayed. Double-click on the icon to add the data set to the
display.

To collapse the sensor list under an individual MicroLogPRO,
click the minus sign (-) next to the MicroLogPRO icon.
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To display the complete sensor list under an individual
MicroLogPRO, click the plus sign (+) next to the
MicroLogPRO icon.

To remove an individual MicroLogPRO from the Data Map,
right-click on its icon, then click Remove data.

To remove all data sets from the Data Map, right-click the

Data sets icon ’E| , then click Remove all data.

The Cursor

Use the cursor to view individual data recording values, or to
reveal a hidden Y-axis. MicroLab enables you to display up
to two cursors simultaneously.

To display the first cursor, double-click on an individual data

point or click Cursor g on the graph toolbar. You can
42
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drag the cursor with the mouse to any other point on the plot,
or to another plot altogether.

The point coordinates of the selected data recording will
appear in the status bar at the bottom of the graph window.
To display a second cursor, double-click anywhere on the

graph or click Second cursor on the graph toolbar.

Zooming and Panning
1. Zooming

Click Zoom in gl on the graph toolbar and drag the cursor
diagonally to select the area you want to magnify. Release
the mouse button to zoom in to the selected area.

Click on the Zoom in button a second time to turn off the
Zoom tool.
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2. Autoscale

2| on the graph toolbar for the full data

Click Autoscale !
display.
Double-click on an individual axis to auto scale it separately.

3. Manual scaling

a. Click Graph properties on the graph
toolbar to open the Graph Properties
dialog box.

b. Select the Scale tab, and choose the axis
you want to scale in the Select axis drop-
down menu.

c. Unselect the Auto scale check box and
enter the new values in the value fields.
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d. In the time axis, you can either enter the
time and date manually, or select it with
the up and down arrow buttons.

e. Click OK.

To restore auto scaling, click Autoscale E

4. Default zooming

If you usually need to view a specific time frame (i.e.
workday hours), use the Default zooming tool. You can set
the start and end time of the time span and then use it
whenever you open a file or download data from the
MicroLogPRO.

To set the default zoom:

a. Click Graph Properties on the graph
toolbar, then click Set Default Zoom.
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b. Enter the start and end times, then click
Set.
To zoom to the default zoom:

a. Click Graph Properties
toolbar.
b. Check the Use default zoom check box
and click OK.
Every file and every data recording you download will
automatically open in the default zoom as long as the Use
default zoom check box remains selected.

iy

on the graph

To restore auto scaling, click Autoscale
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5. The Stretch/Compress Axis Tool
Move the cursor onto one of graph axes. The cursor icon

changes to a double arrow symbol (<), indicating that you
can stretch or compress the axis scale. Drag the symbol to
the desired location. Repeat the procedure for the other axis,
if necessary.
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6. Panning
Use the pan tool after zooming any part of the graph that is
outside the zoomed area.

To do so, click Pan &l on the graph toolbar, then click
anywhere on the graph and drag the graph to view another
area.

Click Pan a second time to turn off the Pan tool.

Cropping the Data

Cropping enables you to trim the edges of a data set. Use it
to remove unwanted data.
1. Zoom to the data range you want to keep.
2. Click Graph on the menu bar, then click Crop.
All data outside the zoomed area will be permanently
removed.
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Formatting the Graph

You can change a data line’s color, style or width. You can
also add markers that represent the data points on the graph
and format their style and color.

The Y-axis color matches the corresponding plot’s color and
will change accordingly. The time axis color can be changed
separately:

1. Click Graph properties on the graph toolbar to
open the Graph Properties dialog box.

2. Select the Lines tab, then select the plot or axis you
want to format in the Select plot drop-down menu.

3. From here, you can format the line’s color, style and
width, as well as the markers’ color and style. To
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remove the line or the marker, uncheck the
corresponding visible check box.

4. To restore the default formatting, click Restore default,
and click OK.

Displaying Alarm Levels

A

1. Click Display alarm level .
2. Select the sensor you wish to display from the Select

ITemperature [Internal) j

sensor drop-down menu

Changing the Temperature Units

oC
Click Toggle °C/°F button A to change the temperature
scale from Fahrenheit to Celsius and vice versa.
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Note: To change the units in the MicroLogPRO display, use
the Setup dialog box (refer to page 58).

Adding Annotations to the Graph

MicroLab allows you to add annotations to the graph. An

annotation is always attached to a specific data point.

To add an annotation:

1. Place the cursor on the point to which you want to add
the annotation.

2. Click Add new annotation on the graph toolbar

3. Type the annotation in the New annotation caption text
box.

4. Click OK.
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To move an annotation:

1. Click Move annotation @ on the graph toolbar
Drag the annotation to any location on the graph you
choose.

3. Click Move annotation a second time.

To edit an annotation:

1. Place the cursor on the point to which the annotation is
attached.

Click Graph on the menu bar.

Click Edit annotation.

Edit the annotation in the text box.

Click OK.

abhwb
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To delete an annotation:

1. Place the cursor on the point to which the annotation is
attached.

2. Click Graph on the menu bar.

3. Click Delete annotation.

To hide all annotations:

1. Click Graph on the menu bar.
2. Click Show annotations to uncheck it.

Exporting Data to Excel

Click Export to Excel to export the currently displayed
data to an Excel spreadsheet. MicroLab will open a new
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Excel workbook displaying the data along with the
MicroLogPRO info, including the MicroLogPRO name, serial
number and alarm levels setup.

Export File Settings

If MicroLab Plus fails to export the data properly i.e. all of the

data is displayed in one row of the worksheet, you can

change the export file settings. This ensures that the data is

exported using comma separated values (CSV).

1. Click File on the main menu, then click Export file
settings,

2. Select the Ignore regional settings check box.

3. Click OK.
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Copying the Graph as a Picture

You can copy the graph to the clipboard as a picture and
then paste it into other Windows programs, such as Word
and PowerPoint:

1. On the Graph menu, click Copy graph.

2. Open the destination file.

3. In the destination file, right-click and select Paste.

Viewing more than one data set on the graph

MicroLab lets you view more than one data set in Graph and
Table view at the same time, allowing you to compare the
data from several data sets side by side.

Note: To use this feature the data sets must have been
recorded using the same sampling rate e.g. every 1 minute

55



Chapter 1 MicroLogPRO .F
There are two modes when using the Multi-graph feature:

e Standard mode

The time scale of all data on the graph is the same. The time
and date of data recorded in the first data set included on the
graph is used.

For example, if you have a graph whose data was recorded
starting 10:00AM on August 11, then all additional data
added to the graph will be displayed with the same recording
date.

The MicroLab data table below shows all data in the graph
having the same time scale:
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[MicrologPRG [MicrologPRO3  [Microlog PRO 4|

Time {Dake) | Hurnidity (%) | Temperature (#C) | Temperature {*C) |
a 10-Aug-06 16:53:50 39.0 2590 22,80
1 10-Aug-06 16:54:00 | 39.1 25.90 22,80
2 10-Aug-06 16:54:10 | 39.1 25.90 22.80
Eo| 10-Aug-06 16:54:20 | 39.1 £5.90 22,80
4 10-Aug-06 16:54:30 | 39.1 25.90 2z2.80
5 10-Aug-06 16:54:40 | 39.1 2590 22,80
(&) 10-Aug-06 16:54:50 39.2 25.90 22,80
7 10-Aug-06 16:55:00 39.2 25.90 2z2.80
g 10-Aug-06 16:55:10 39.2 £5.90 22,80
9 10-Aug-06 16:55:20 | 39.1 25.90 22,80

e Plot sync mode
To display data on the graph using the data’s actual time
scale i.e. the time and date when the data was actually
recorded, use the Plot sync feature. This will also shift all
data in the data table accordingly.
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Once you've added the data to the graph, on the Graph
menu, select Plot sync to enable the feature. To return to
Standard mode, unselect Plot sync.

Note: The time scale of all data is rounded to the same
resolution as the time scale of the original data on the graph.

1.4.5. Programming MicroLogPRO

Setup

Use the Setup dialog box to view or change the
MicroLogPRO and Cradle settings.
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Note: If you intend to setup more then one MicroLogPRO or
Cradle, use the Save Setup tool (refer to page 68).

1. Connect MicroLogPRO or the Cradle to the PC.

2. Click Setup to open the Setup dialog box.
The dialog box consists of five sections:

¢  MicroLogPRO info

Comment
Click the text box and type a name that will serve to
identify the specific MicroLogPRO (e.g. its location).

S/N
Displays the MicroLogPRO’s serial number.
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Battery Level
If the indicator is in the red zone the battery should
be replaced (refer to page 24).

e Cradle info

Cradle ID
The cradle’s identification number sets the cradle’s
transmission time in daily download mode.

Battery Level
If the indicator is in the red zone, the battery should
be replaced (refer to page 202).
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o Setup

Temperature
Select the Temperature check box to activate the
internal temperature sensor.

Humidity
Select the Humidity check box to activate the
internal humidity sensor.

External
Select the External check box to activate the
external sensor option, and then select a sensor in
the drop-down menu.
If you want to use a sensor that is not found in the
drop-down menu, you can define a new sensor
(refer to page 76).
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Note: The sensors’ current readings will appear next to the
sensor name once MicroLogPRO begins logging for the first
time.

Temperature unit
To set the temperature unit in the MicroLogPRO
display, select the option you want (Celsius or
Fahrenheit).

Interval

This determines the logging interval, or the time
interval between successive data recordings.

The time format is hh:mm:ss. Set the time setting to
select a recording time interval from 10 seconds to 2
hours. For example, to set a time interval of one
hour, five minutes and thirty seconds, click the hours
(hh) and type 1 or use the arrows to select 01. Click
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the minutes (mm) and type 5 or use the arrows, and
finally, click the seconds (ss) and type 30 or select
30 using the arrows.

Timer run
Select the Timer run check box if you want
MicroLogPRO to start recording at a predetermined
time. This option is convenient if you are using
several MicroLogPROs at once and want them to all
begin logging at the same time.
Use the time and date selectors to set the start time.

Cyclic run
In Cyclic run mode, MicroLogPRO overwrites the
old measurements (starting with the oldest recorded
data) once the MicroLogPRO’s memory is full. Click
the Cyclic run check box to operate in this mode.
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If the check box is clear, MicroLogPRO will operate
in Normal run mode and will stop recording when
the memory is full.

Push to run
In Push to run mode, the MicroLogPRO will only
start recording data when you press either the left or
right logger button. It is convenient for when you
wish to start recording data soon (but not
immediately) following setup, or at an unspecified
time.

Daily download
Select the Daily download checkbox to enable
automatic daily download (refer to page 81 for
details).
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e Alarm levels

Type in the desired minimum and maximum alarm levels. If
MicroLogPRO records a reading that exceeds either of these
levels, the MicroLogPRO’s LCD will display alarm notification
and the cradle’s alarm will sound.

To remove the alarm sign from the display, press

either of MicroLogPRO’s two buttons. To stop the

cradle’s alarm from sounding, press both of the
MicroLogPRO’s buttons simultaneously.

The default alarm levels are the lower and upper

ends of the sensors. Click Cancel Alarm to restore

the default levels.
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e Alarm time settings

Workday hours
Use the up and down arrow buttons to set the daily
period when you want the Alarm and/or the Daily
Download to be active, or type the desired period in
manually.

Alarm delay
Use the drop-down menu to select the time delay
between the time MicroLogPRO records a reading
that exceeds the alarm levels and the time the alarm
will sound.
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Alarm duration
Use the drop-down menu to select the time for which
the alarm will sound before it stops automatically.

Completing the Setup

Click Send Setup to send the new settings to the
MicroLogPRO. This will complete the setup. Click Cancel if
you do not wish to change the setup at this stage.

Note: The Send Setup command erases all existing data in
the MicroLogPRO.
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If you select Timer run mode, MicroLogPRO will wait in

standby mode, displaying . It will begin recording at the
specified time.

Saving Setup

When setting up multiple MicroLogPROs or Cradles, use the

Save Setup option in the Setup dialog.

1. After you have finished the settings selection of the first
MicroLogPRO or Cradle and before sending the setup
command, click Save Setup to save all of the setup
settings.
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2. Connect another MicroLogPRO or Cradle to the PC and

SETUP

click Setup @ on the main menu.

Click Load Setup to load your setup settings.
Change the Cradle ID.

Change the Comment (optional).

Click Send Setup.

I

Starting Data Recording

Click Run @tf every time you want to start a new recording.
The Run command erases all previous data in the
MicroLogPRO’s memory and begins recording.
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Note: If you setup the MicroLogPRO using the Setup
command, it will automatically begin recording, and you don’t
have to click Run.

Stopping Data Recording

Click Stop @ to stop recording. In Stop mode,
MicroLogPRO keeps all recorded data but does not record
new data. Use this mode to save battery power.

Sensor Calibration

A new MicroLogPRO comes fully calibrated. After a long
period of use however, you may want to recalibrate the
humidity or the temperature sensors.
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The calibration affects both MicroLogPRO and MicroLab and
should be carried out while MicroLogPRO is connected to
the PC.

Calibration Password

To prevent accidental change of the calibration, the
calibration procedure is protected by a password. The default
password is: 1234. To change the password:

1.
2.

3.

Click Logger on the main menu, then click Calibration.
Click Change Password to open the Change
Password dialog box.

Enter the current password in the Current Password
field.

Enter the new password in the New Password field.
Enter the new password a second time in the Confirm
New Password field to confirm your new password.
Click OK.
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Note: The password must include at least 4 characters and
is case sensitive.

Humidity Calibration

To calibrate the humidity sensor you will need a humidity

chamber.

1. Connect MicroLogPRO to the PC.

2. Set up MicroLogPRO to record every 10 seconds (refer
to page 58).

3. Click Logger on the main menu, then click Calibration.

4. Enter the calibration password, then click OK.

5. Select Humidity in the Choose sensor drop-down
menu.
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6.

MicroLogPRO

Calibration E‘
Choose sensor Humidity 5
Calibration Yalues :
Reference  Microlog
valug valug

First value a3 1}
Second valus : 76 0

Default Calibrate
Close

Figure 4: Humidity calibration

Click Default to restore the original values.

Chapter 1
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7. Disconnect MicroLogPRO from the PC and insert it into
the humidity chamber.

8. Set the humidity chamber to the first reference value.
Wait until the humidity level is stabilized and write down
MicroLogPRO’s reading.

9. Repeat the last step with the second reference value.

10. Connect MicroLogPRO to the PC.

11. Enter the two MicroLogPRO values into the
MicroLogPRO value text boxes.

12. Enter the two reference values into the Reference value
text boxes.

13. Click Calibrate.

To restore default calibration, click Default.
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Temperature Calibration

hPOON=

o o

8.

Connect MicroLogPRO to the PC.

Click Logger on the main menu, then click Calibration.
Enter the calibration password, then click OK.

Select the desired temperature sensor in the Choose
sensor drop-down menu.

Click Default to restore the original values.

Enter the two MicroLogPRO values into the
MicroLogPRO value text boxes.

Enter the two reference values into the Reference value
text boxes.

Click Calibrate.

To restore default calibration, click Default.
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Defining a Custom Sensor

You can use MicroLogPRO with any sensor that has a 0 —
20mA current output or a 0 — 10V voltage output.

1. Click the Logger on the main menu and then select
Define new sensors to open the Define New Sensor
dialog box.

Click Add to add a new sensor to the list.

In the Based on drop-down menu, select an external
sensor that matches your sensor’s output.

Type the sensor’s name in the Sensor Name text box.
Type the sensor’s unit in the Sensor Unit text box.

In the Calibration Values section, enter two values of
your sensor that correspond to the base sensor values.
For example, see the definition for a 0 — 100mbar
pressure sensor whose output is 0 — 20mA:

wn

IS
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Define New Sensor

Based on:

Ext. Current - 20m4 =

MicroLogPRO

SensorHame: [Prossurs
SensorUnit:  [mb

Caibration Values
Base Hew

Sensor Sensor
Vale#l: [0 0]
Valetiz: |20 100

ok Cancel

Chapter 1

%]

Figure 5: Defining a new sensor

7. Click OK.

The new sensor will then appear in the External Sensor list in

the Setup dialog box.
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Setting IR Printing Format

1.
2.

78

Connect the MicroLogPRO to the PC.
Click Logger on the menu toolbar, then click
MicroLogPRO IR Print Settings:

IR print settings dialog

& Frint format 1
" Print format 2

Figure 6: IR Print Settings dialog box
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3. Select a format option:
a. Print Format 1 — Prints the minimum and
maximum values of a selected time period up
to the last 30 days (refer to page 20).
b. Print Format 2 — Prints all data up to 128 rows
of data
4. If you selected Print Format 2, enter the desired number
of rows (up to 128).
5. Click OK.

Communication Setup

Communication between the PC and the MicroLogPRO unit
takes place automatically whenever you send a command to
MicroLogPRO. However, the Communication Setup dialog
box can be used for more advanced communication options.
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Click Logger on the main menu and select Com setup to
open the Communication Setup dialog box:

If you are not using a Receiver and Cradle, uncheck the
Search for Receiver and Cradle checkbox in order to
speed up the search.

Communication Setup @

Select Port

COM1
COM3

IV Search for Receiver and Cradle

iyt connect - ok offine | Cancel |

Figure 7: Communication Setup dialog box
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The selected COM ports are available for communication.
1. Click Try to connect to establish communication.
2. Click Work offline to work with saved files.

1.4.6. Automatic Daily Download

You can program all the MicroLogPROs on your line to
automatically transmit their data to a PC every day, at a
preset time.

To work with this option you will need to mount the
MicroLogPROs onto wireless Cradles (refer to page 196)
and connect a Receiver to the PC (refer to page 209).

Prepare the MicroLogPRO.

To prepare a cradle with the MicroLogPRO for daily
download:
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1. Connect the cradle to the PC (refer to page 199).
2. Setup the MicroLogPRO and cradle (refer to page 58).

Notes:

e Enter an identification number for the cradle in the Unit
ID text box. The number should be an integer between 1
and 200. Every cradle should have a different ID
number. (For added convenience, we recommend
attaching a label with the ID number to every cradle).

e The recording interval must be equal to or greater than 1
minute for recording data from one sensor, 2 minutes for
2 sensors and 3 minutes for 3 sensors.

3. Check the Daily download checkbox.
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4. To set the download time and file location, click Daily
download at the bottom of the setup dialog to open the
Daily download dialog box.

5. Enter the desired download time in the Download start
time field.

MicroLab automatically calculates and sets the cradles’

transmission times according to their ID numbers, so that the

cradles will transmit the data successively.

6. MicroLab creates a new daily download file every 24
hours. Set the time at which these files are created in
the Create new daily download file at field.

7. For advanced file management, check the Auto file
management check box.

In this mode, MicroLab searches in every download for
previously missing data and updates the corresponding
files.
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8.

10.

12.

13.

84

MicroLab stores the data files in the following folder by
default:

C:\Program Files\Fourier
Systems\MicroLab\WMicroLogPRO Data\Daily download.
If you want to store your data in another location, click
Browse and navigate to the desired folder.

Click OK to return to the Setup dialog.

Click Send Setup.

. Repeat this procedure (except for steps 4 to 9, which

should be performed only once) with every cradle.
Remember to assign a different ID number to each
cradle.

After you have finished setting up all your cradles,
connect the RF receiver to the PC (refer to page 209).
Click Logger on the main menu, then click Com setup
to open the Communication Setup dialog box.
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Make sure that the Search for Receiver and Cradle
checkbox is selected.

14. Click Try to connect to establish communication with
the receiver.

15. Place the cradles at the desired data logging locations.

Automatic Download

At the download start time the cradles should be within 300m
of the receiver and in its line of sight. The cradles will
automatically transmit the data one after the other according
to their ID number. The time interval between successive
transmissions is two minutes.

MicroLab automatically saves the data after every
transmission under the name: daily download [&date]. After
the daily download has been completed, the file will
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automatically be closed. MicroLab creates a new data file
every 24 hours.

Manual Transmission

If one of the cradles fails to transmit data automatically, or if
you need to download all data from a specific cradle (not just
data that was recorded during working hours), press the Trs
(Transmit) button on the right side of the cradle (refer to page
199). The cradle will then transmit all stored data to the PC.

Viewing Daily Download Data and Status
To open a daily download data file:

1. Click Open J

86

on the main toolbar.
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2. Navigate to the folder in which the daily download data
files are stored.
3. Double-click the file name to open the file.

MicroLab prompts to a daily summary of the automatic

download. The summary includes a list of the MicroLogPROs

that have completed their data download, along with their

respective cradle’s battery level, transmission status and

indication as to whether or not alarm levels were exceeded.

4. Click OK to close the Summary window and to display
the data.
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1.4.7. Analysis Tools

Setting the Analysis Tools Parameters

1. Click Analysis on the menu bar, then click Set
Functions’ Parameters to open a dialog box:

Functions’ Parameters Dialog 3]
noo
o
HighLink I
Fo Pasteurization
Reference Temperature: 121
Temperature Of Bacterium Death: 10

Figure 8: Functions Parameters
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2. Type in the desired parameters, then click OK.

Histogram

Use this tool to create a frequency distribution of the selected

data set.

To create a histogram:

1. Use the cursor to select a plot on the graph.

2. Click Analysis on the main menu bar, then click
Histogram.

MicroLab displays a histogram of the selected data and
creates a new entry in the Data Map.

Use the Data Map (refer to page 40) to hide the histogram or
to return to the original data sets.
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You can modify the histogram to your needs. You can set the
upper limits of the first bin and the lower limit of the last bins,
and refine the histogram by increasing the number of bins.

To modify the histogram:
1. Click Analysis on the main menu, then click Histogram
a second time to open a dialog:

Histogram settings

First bir 0.5
Biirn width: 10
Last bin E5.5

v

Figure 9: Histogram settings
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2. Enter the desired values for the first bin, the bin width
and last bin, then click OK.
You can repeat the process for further modification.

Pasteurization

Use this tool to create and display an FO Pasteurization
curve:

Click Analysis on the menu bar, then click FO
pasteurization.

Statistics

Use the statistics tool to display statistics of each data set in
the graph.

The statistics include:

Minimum — The smallest value in the data set.
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Maximum — The largest value in the data set.

Average — The average of all the numbers in the data set.
MKT — The mean kinetic temperature (for temperature data
only).

To display statistics:

Click Statistics 2 on the main toolbar.

MicroLab will display the statistics in the information bar at
the bottom of the graph window.

>

To hide the statistics, click Statistics a second time.
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1.4.8. Toolbar Buttons

Main (Upper) Toolbar

G Open Opens saved files
E s Saves the data that is currently
ave :
displayed
ﬁ Print... Opens the Print Option dialog box

Exports the displayed data to an Excel
Export spreadsheet
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Run

Stop

Setup

Download

Data Map

Graph

MicroLogPRO -I:

Begins recording data
Stops recording data

Opens the Setup dialog box

Downloads data from the MicroLogPRO
onto the PC

Displays or removes the Data Map

Displays or removes the graph
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Table

Statistics

°C/°F

Alarm

MicroLogPRO Chapter 1

Displays or removes the table
Displays or removes the data’s statistics

Displays the desired unit of temperature

Displays or removes alarm levels from
the graph
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Graph (Lower) Toolbar

Add .
“nhotation \dds new annotation to the graph

Move

. Relocates the annotation on the graph
annotation

Pan Activates the pan tool

Ql Zoom in Activates the zoom tool
=Y

Autoscale  Returns the graph to full view
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Graph _ .
properties  OPens the Graph Properties dialog box
Cursor Toggles the first cursor

Second Toggles the second cursor

cursor
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Chapter 2 MicroLab Plus
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2.1. Overview

The MicroLog Plus solution enables simultaneous, wireless
communication between a PC and up to 200 MicroLogPRO
units. Furthermore, real-time temperature and humidity
readings from the MicroLogPRO are automatically delivered
directly to the PC. Data from external sensors can also be
transmitted in the same manner. The complete MicroLog
Plus solution includes the MicroLogPRO data logging device,
the cradle that the data logger is mounted on, a small
receiver that is placed on the PC, and the user-friendly
software that allows for convenient central management.

MicroLog Plus uses MicroLogPRO data loggers to record
temperature and humidity readings. The cradle that the data
logger is mounted on is a wireless transmitter that can
transmit measurements to a PC from up to 300 meters.
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Since each cradle is tagged with an ID number, the cradles
can be programmed to transmit data at various time intervals
based on the criteria defined in their IDs. This advanced
feature prevents data collision between two or more loggers.
The MicroLab Plus software reports on the status of up to
200 MicroLogPROs on a single color-coded interface. Other
features that help automate all aspects of the industrial data
logging procedure include the ability to store the data of each
MicroLogPRO, to set MicroLogPRO alarm levels and to
define sampling intervals, as well as any other necessary
parameters.

The Logger menu handles all communication between the
PC and MicroLogPRO, such as programming the desired
MicroLogPRO and Cradle, calibrating sensors, as well as
defining new sensors.
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The View menu controls the various data display options.
Online data can be viewed in multiple meters format (the
default view), in multiple graph format, or Cradle Map format.
The stored data can be viewed on an offline graph and table.
The Offline Graph menu contains all the commands needed
to format and edit the graph.

The Cradle Map menu contains all the commands needed to
setup and edit the map.

The Multiple Graphs menu contains all the commands
needed to view and edit the graphs.

The most common tasks and commands are available as
icons on the Main toolbar (upper toolbar), the Graph
toolbar (lower toolbar) and on the Cradle Map toolbar
(lower toolbar).
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2.1.1. MicroLab Plus Default Window Layout

In Meters view (the default view), the data for each
MicroLogPRO is displayed in a separate window in a meter.
There are six MicroLogPRO windows in each display. The
image below represents an individual MicroLogPRO display.
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ID 2 MicroLog PROZ2 =
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MicroLlog LA 28-5ep-05 10:40:01

Figure 10: MicroLogPRO Meter view

The blue and red zones on the meters represent the low and
high alarm level thresholds, respectively.
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2.2. Getting Started

2.2.1. Installation

System Requirements

To work with MicroLab Plus, your system should be

equipped with the following:

Software

e  Windows 95, or later (Windows 95 will not support USB)

e Internet Explorer 4.0, or later (you can install Internet
Explorer 5 when you install MicroLab Plus, since it ships
with the product)
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Hardware

Pentium 300MHz or higher

32 MB RAM (64 MB recommended)

5 MB available disk space for the MicroLab Plus
application

Installing the Software

1.
2.

3.

Insert the CD into your CD drive.

The installation will start automatically. Once the
process begins, follow the on-screen instructions.

If auto run is not working, open the CD drive folder and
double-click the setup icon, then follow the on-screen
instructions.
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To uninstall the software: From the Start menu select
Settings > Control Panel, and use the Add/Remove
Programs tool to remove the MicroLab Plus application.

To install the USB driver (optional):

1. Insert the CD into your CD drive. If Installation begins
automatically (and you have already installed MicroLab
Plus), click Cancel to stop installation.

2. Connect the Cradle to a USB port on your PC. Windows
will automatically detect the new device and open the
Add New Hardware Wizard.

3. Select Specify the location of the driver, then click
Next.

4. Select Search for the best driver for your device,
then check the Removable Media checkbox, and click
Next.
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Windows will automatically detect and install the necessary
software.

2.2.2. Setting up the MicroLog Plus System

Before you start using the MicroLog Plus system you must
connect each Cradle to the PC wusing the serial
communication cable and set it up. Follow the steps below to
setup your system:

1. Mount the MicroLogPROs onto the cradles.

2. Open the MicroLab Plus software.

3. Connect the first cradle to the PC (refer to page 199).

4. Set up the first MicroLogPRO data logger (refer to page
159).

Disconnect the first cradle from the PC.

Repeat steps 3 — 5 with each cradle.

oo
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Note: When setting up multiple Cradles, we recommend
using the Auto Setup tool (refer to page 169).

7. Connect the RF receiver to the PC (consult your
Receiver user guide).

8. Click Logger on the main menu, then click Com setup
to open the Communication setup dialog.

9. Click Try to connect to establish communication with
the receiver.

10. Place the cradles at the desired data logging locations.
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Note: If you encounter problems in the wireless connection
between a certain cradle and the receiver, you may need to
use Fourier's Repeater device to extend the transmission
range.

2.2.3. Selecting Active Cradles

MicroLab Plus enables you to select what cradles you wish

to monitor. This option is especially useful if another

MicroLog Plus system is working nearby and interferes with

your system.

To select the cradles you wish to monitor:

1. Click File on the main menu, then click Set Active
Cradles.
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110

Active Cradles Selections

Active Cradles

]

Cancel

Figure 11: Active Cradles selection

Select the All option to monitor all the cradles that
transmit data to your system.

To monitor only specific cradles, select Custom, then
enter the cradles’ ID number separated by commas (for
example, 2,3,7,12).

Click OK.
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2.2.4. Saving Data

There is no need to save data manually as the data is saved
automatically every half an hour in the MicroLogPRO Data
folder:

C:\Program Files\Fourier Systems\MicroLab
Plus\MicroLogPRO Data.

However, you are able to change the file location. MicroLab
Plus creates a folder for each MicroLogPRO unit, naming it
with the cradle ID number. The MicroLogPRO’s data is
stored in this folder.

MicroLab Plus creates a new data file for each MicroLogPRO
every 24 hours, at midnight.

By default the data is saved in the MicroLab Plus file format
(.MPD - MicroLabPlus data). If you want to use the data in
another program you can save it as a text file (.CSV -
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comma separated values). The data can then be saved in

either one of, or both of, the file formats.

To select the file format and location:

1. Click File on the main menu, then click Stored data
folder...

2. To save data in the MicroLab Plus file format, check the
Save MicroLab Plus files check box.

3. To change the file location, click Browse and navigate
to the desired folder.

4. To save the data in text file format, check the Save text
files check box.

5. To change the file location, click Browse and navigate
to the desired folder.

6. Click OK.
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Note: If you want to remove unwanted data from the graph,
apply the crop tool (refer to page 155).

Backing Up Files

When the configuration of a cradle changes, the data that
was accumulated until now is saved in a backup folder.

For example: Let’s say that after saving data from Cradle ID
2 for several hours, you change its configuration and remove
the temperature sensor. When the new data arrives, the old
one will not be deleted but will be saved in a backup folder.
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2.2.5. Activating the Sound Alarm

Click Enable Alarm \9

the sound alarm.

If any MicroLogPRO records a reading that exceeds its alarm
levels, or if the connection with any of the cradles is lost, the
MicroLab Plus alarm will sound.

The alarm will sound as long as the MicroLogPRO readings
exceed the alarm levels or until connection with the cradle
resumes.

To disable the alarm of an individual cradle, click Reset

on the main toolbar to activate

alarm in the upper right corner of that particular
cradle’s window in the Meters view.
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Click Enable Alarm on the main toolbar a second time to
disable the Alarm completely.

Note: To activate the Cradle alarm, use the Setup dialog
box.

2.2.6. E-mail Alarm Notification

MicroLab Plus can be programmed to send e-mail
notifications to one or more e-mail addresses in any of the
following cases:
e Sensor alarm
Notification that the cradle sensors have breached their
high or low alarm level.
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e Lost cradle connection
Notification that the cradle has either stopping sending
data to the MicroLab Plus, or that it has come back
online.

e Low battery indicator

The notifications include the MicroLog name, the sensor

whose alarm level was exceeded and the sensor's measured

value.

To setup MicroLab Plus in order to send e-mail notifications:

1. Click File on the menu bar, then click Mail properties to
open the Mail properties dialog box.
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2.
3.

MicroLogPRO Plus

Mail properties
W Send e-mail notifications

To:
Frorm:

¥ Use subject heading prefit

Server name [SMTP

¥ My server requires authentication

Account name:

Password:

-

Cancel |

Far example: john(@yahoo.com
Far example: john@yzhoo. com
Test | Filersetings |

Chapter 2

Check the Send e-mail notification check box.
In the Server name box, type the outgoing mail server
name (mandatory).
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4.

5.
6

118

In the To box, type the e-mail address of each recipient,
separating names with a semicolon (;) (mandatory).

In the From box, type your e-mail address (mandatory).
If your server requires authentication, enter the account
name and password as relevant.

If you require a specific subject heading in your emails,
enter the prefix in the Subject heading prefix text box.
Click Test to verify that the email properties were
entered correctly. Your default email client should
receive an email from the MicroLab Plus within seconds.
If the email was received, click OK to exit the Mail
properties dialog.
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2.2.7. E-mail Events Filter

You have the ability to filter the type of email notifications you

receive.

This will give you greater control over the frequency of email

alarms generated by the software, and will in turn reduce the

traffic to your email inbox.

1. Go to File > Mail Properties and click Filter settings in
the Mail properties dialog box.

2. The e-mail Events Filter window will open up:
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e-mail Events Filter [g|

Send e-mail alertz for the following events anly:

v Senzor alam

™ Send email alart only after Cyecles

|v Lost cradle connection

[ Laow battery level

Ok | Cancel |

3. Select the checkboxes according to which alarm event
you want to receive. If no checkbox is selected, you
have effectively disabled the email alarm notification
feature.

120




.F MicroLogPRO Plus  Chapter 2

4. Click OK to apply the changes.

2.2.8. Delaying Email Notifications

In the email Events Filter dialog, you have the option to
delay the sending of the email notification when your system
goes into sensor alarm. You can determine that if the system
returns to normal conditions from anywhere between 2 to
100 cycles after the initial alarm, then an email is not sent.
This feature is useful when wishing to minimize the number
of alarm notifications as a result of a legitimate change in the
environment.
1. Go to File > Mail Properties. Click on Filter
settings to open the email Events Filter dialog.
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e-mail Events Filter

Iv Sensor alarm

Send e-mail alerts far the fallowing events anly:

v Send email alert only after |B | Cycles

I” Lost cradie connection 2 ~
[ Low battery level g

7 ~

| 0K | Cancel |

MicroLogPRO Plus

X

Select the Sensor alarm checkbox and then select
the Send email
checkbox. You may select between 2 and 100

cycles.

alert only after X cycles
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If the MicroLog PRO returns to the pre-alarm level before the
selected number of cycles is reached then no email is sent.

If the MicroLog PRO is still in alarm when the number of
cycles is reached then an email is sent. Another email will be
sent once the logger is out of alarm.

2.2.9. Alarm Trigger Settings

Using this feature will enable you to trigger a cradle alarm
only after a combination of alarm parameters has been met.
Once these alarm levels are breached, MicroLab Plus will
indicate that cradle is in alarm (this includes e-mail
notification).

You can define a combination of at least two of the following
sensor types:
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Internal temperature sensor
Internal humidity sensor
External sensor

Cradle contact

For example, you can determine that for those cradles
running the internal temperature sensor and an external
sensor, only when MicroLab Plus records alarms from both
of these sensors will the alarm sound.

However, MicroLab Plus will indicate an alarm for cradles
recording data using sensors other than what is defined in
the Alarm trigger settings setup.

For example, if you selected an alarm trigger for a
combination of the temperature, humidity and external
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sensors, but a cradle running just the temperature and
humidity sensors go into alarm, MicroLab Plus will indicate
an alarm for that cradle.

1. Go to File > Alarm trigger setting to launch the dialog

box:
2. You must select a combination of at least two triggers.
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Alarm trigger settings dialog ['STI

I¥ Internal termperature sensor
¥ Internal humidity sensor
[ External sensor

I Cradle contact

oK | Cancel |

Enabling the alarm trigger applies to alarm emails, sounding
of the alarm in the software, alarm indication in the Cradle
map, and alarm indication in the mail MicroLab Plus window.
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2.2.10. Changing the Temperature Units

°C

e
Click Toggle °C/°F button to change the temperature

scale from Fahrenheit to Celsius and vice versa, in the
MicroLab Plus graph and data displays.

Note: To change the units in the MicroLogPRO display, use
the Setup dialog box or the Logger menu.

2.2.11. Display Properties

You can change the way numbers and dates will be
displayed on screen.
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1. Click File on the main menu, then click Display
Properties.

2. In the Decimal place settings, enter the number of
decimal places you want to display (enter a number
between 0 and 4) for each sensor.

3. In the Date format settings, select the desired format
option.

4. Click OK.
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2.3. Online Mode

2.3.1. Display Options

Online data can be displayed in:

e Meters View (the default view), in which the current data
is displayed in meters.

e Multiple Graph View, in which the data from the last 24
hours is displayed in graphs.

e Cradle Map format, where the MicroLogPRO units are
represented by color coded icons.
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2.3.2. Meters View

Click Meters on the main toolbar to switch to Meters
view.

In Meters view (the default view), the data for each
MicroLogPRO is displayed in a separate window in meters.
The number of active meters in the window corresponds to
the number of active sensors in each MicroLogPRO. The
meters are updated every time MicroLab Plus receives new
data.

If a MicroLogPRO is inactive, the corresponding window is
disabled (is grayed-out).

There are six MicroLogPRO windows in each display. If you
are using more than six MicroLogPROs, you can manually
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scroll to the other displays, or let MicroLab Plus do this

automatically.

e Click Auto scroll L on the main toolbar to allow
automatic scrolling. Click Auto scroll a second time to
return to manual scrolling.

e Click Scroll forward on the main toolbar to
scroll to the next MicroLogPRO unit’s display.

e Click Scroll back on the main toolbar to scroll to
the previous MicroLogPRO unit’s display.

131



Chapter2  MicroLogPRO Plus .F

2.3.3. Multiple Graphs View

|

Click Multiple graphs B 5n the main toolbar to switch

to Multiple Graphs View.

In Multiple Graphs View, the data for each MicroLogPRO is
displayed in a separate window in graphs. The graphs
display the data sets plotted versus time. In order to keep the
graph clear and easy to read, only two Y-axes can be shown
on the graph simultaneously. If there are three curves in the
graph, one of the Y-axes will be hidden. To make this axis
visible, select the corresponding plot with the cursor.

You can identify the Y-axis by its color, which matches the
plot color.
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The graphs are updated every time MicroLab Plus receives
new data. If a MicroLogPRO is inactive, the corresponding
window is disabled (is grayed-out).

There are six MicroLogPRO windows in each display. If you
are using more than six MicroLogPROs, you can manually
scroll to the other displays or let MicroLab Plus do this

automatically.

e Click Auto scroll L‘ on the main toolbar to allow
automatic scrolling. Click Auto scroll a second time to
return to manual scrolling.

e Click Scroll forward on the main toolbar to
scroll to the next MicroLogPRO unit’s display.
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e Click Scroll back on the main toolbar to scroll to
the previous MicroLogPRO unit’s display.

The Cursor

Use the cursor to view individual data recording values, or to
reveal a hidden Y-axis.

To display the cursor, click Cursor bﬁ on the graph
(lower) toolbar. You can drag the cursor with the mouse to
any other point on the plot, or to another plot altogether.

The point coordinates of the selected data recording will
appear in the information bar at the bottom of the graph
window.
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Zooming

1. Click Zoom in Q} on the graph toolbar and drag the
cursor diagonally to select the area you want to magnify.
Release the mouse button to zoom in to the selected
area.

2. Click on the Zoom in button a second time to turn off
the Zoom tool.

—

1%

3. To restore auto scaling, click Autoscale
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Autoscale

—

1%

Click Autoscale on the graph (lower) toolbar for the

full data display.

The Stretch/Compress Axis Tool

Move the cursor onto one of the graph axes. The cursor icon
changes to a double arrow symbol («), indicating that you
can stretch or compress the axis scale. Drag the symbol to
the desired location. Repeat the procedure for the other axis,
if necessary.

—

1%

To restore auto scaling, click Autoscale
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Panning

Use the pan tool after zooming any part of the graph that is
outside of the zoomed area.

To do so, click Pan @ on the graph toolbar, then click
anywhere on the graph and drag the graph to view another
area.

Click Pan a second time to turn off the Pan tool.

Displaying Alarm Levels

1. Click Display alarm level
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2. Select the sensor you wish to display from the Select
Sensor drop-down menu. For example:

|Extt:rna| j
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2.3.4. Cradle Map

Click Cradle Map on the main toolbar to display the
Cradle Map.

In Cradle Map view, each MicroLogPRO is represented by
an icon. Each icon carries the MicroLogPRO'’s individual 1D
number. When the MicroLogPRO is active, the icon’s color is
green. If the recorded data exceeds either of the alarm
levels, the icon’s color turns to red. Move the cursor over an
icon to display the MicroLogPROQO’s name.

Double-click on any MicroLogPRO icon to display its meters
window, which is identical to its window in the Meters view
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format. To close the meters window, click Close at the upper
right-hand corner of the window.

Before using the Cradle Map, you must first set up and then
lock the map.

Setting up the Cradle Map

1. Click Cradle Map on the main toolbar to display
the Cradle Map or click Cradle Map on the main menu,
then click Display toolbar to display the Cradle Map
toolbar.

mll
2. Click Lock View on the Cradle Map toolbar to
unlock the Cradle Map.

140



.F MicroLogPRO Plus  Chapter 2

Adding Icons
Add icons to match the number of MicroLogPROs you are
using.

+
1. Click Add cradle @ on the Cradle Map toolbar to add
a new icon or use the adjacent drop-down menu to add
a group of 5, 10 or 15 icons at a time.

2. Click Remove cradle -@ or use the adjacent drop-
down menu to remove icons.

Loading an Image

You can arrange the icons on an image or plan of your work
space, so that each icon represents the corresponding
MicroLogPRO’s actual location in the work space.
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First, load the image into the program:

1. Click Load image on the Cradle Map toolbar.

2. Locate the image file you wish to load.

3. Double-click the file name.

You may now click and drag the MicroLogPRO icons to their
desired locations on the cradle map.

Locking the Cradle Map
After you have finished arranging the icons, click Lock View

%l on the Cradle Map toolbar to prevent any accidental
change in the icon arrangement.
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2.4. Offline Mode

2.4.1. Offline Screen

Click Offline g on the main toolbar to switch to Offline
mode.

MicroLab Plus’s Offline screen consists of two parts: the
graph and the table. The data in the table always matches
the data that is currently displayed on the graph.
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2.4.2. Opening Files

In Online mode, the received data is displayed online both in
graphs and in meters.
To display previously saved data, switch to Offline mode:

B

1. Click Offline on the main toolbar.

Click Open J on the main toolbar.
Enter the desired cradle ID number.
Select a date in the From box.

Select a date in the To box.

Click OK.

ook wN
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Note: To open files that where stored in backup files (refer to
page 113), select the Open files from backup checkbox.

The software prompts to the Advanced Open dialog box:

Advanced Open

00:071:00 [hhcmm: ss]

Display rate:

& Average " Close sample

Cancel

Figure 12: Opening files
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You can choose to filter the data and select the time interval

between displayed samples. You can view only the points

that correspond to the selected time interval (or the closest

samples) or you can display the averages of all samples in a

time interval.

1. Select the time interval from the Display rate drop-down
menu.

2. Select either the Average or Close sample option.

3. Click OK.

The data will be loaded between the dates you selected and
displayed in the graph and table display.
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2.4.3. Print

Printing a Graph
You can print saved data in Offline mode.

1.

2.
3.
4.

Click Print :_il on the main toolbar to open the Print
Options dialog box.

Click the Graph option.

Click Print to open the Print dialog box.

Click OK.

Printing a Table
You can also print saved data as a table in Offline mode.
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The table will include data as well as the MicroLogPRO
name, serial number and the alarm level setup. Data that
exceeds any of the alarm levels will be highlighted by arrows.

1. Click Print :_il on the main toolbar to open the Print
Options dialog box.

Click the Table option.

If you want to print only part of the data, unselect the
check box and select the desired time and date in the
From and To fields.

4. Click Print to open the Print dialog box.

5. Click OK.

wnN
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24.4. Graph Display

Graph

The graph displays the data sets plotted vs. time.

In order to keep the graph clear and easy to read, only two
Y-axes can be shown on the graph simultaneously. If there
are three curves in the graph, one of the Y-axes will be
hidden. To make this axis visible, select the corresponding
plot with the cursor.

You can identify the Y-axis by its color, which matches the
plot color.
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The Cursor

Use the cursor to view individual data recording values, or to
reveal a hidden Y-axis.

MicroLab Plus enables you to display up to two cursors
simultaneously.

1. To display the cursor, double-click on an individual data

point or click Cursor lﬁi on the graph toolbar. You
can drag the cursor with the mouse to any other point on
the plot, or to another plot altogether.

2. The point coordinates of the selected data recording will
appear in the information bar at the bottom of the graph
window.

3. To remove the cursor, click Cursor a second time.
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4. To display a second cursor double cl_ick anywhere on

the graph or click Second cursor
toolbar.

5. To remove the second cursor click Second cursor a
second time.

on the graph

Zooming and Panning
1. Manual Scaling

a. Click Graph Properties on the graph toolbar
to open the Graph Properties dialog box.

b. Select the Scale tab, and choose the axis you want
to scale in the Select axis drop-down menu.
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c. Unselect the Autoscale check box and enter the
new values in the text box.

d. In the Time axis, you can either enter the time and
date manually, or select it using the up and down
arrow buttons.

e. Click OK.

—

1%

To restore auto scaling, click Autoscale
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2. Autoscale

—

153

a. Click Autoscale
full data display.

b. Double-click on an individual axis to autoscale it
separately.

on the graph toolbar for the

3. Default Zooming

If you usually need to view a specific time frame (i.e. work-
day hours) use the Default zooming tool. You can set the
start and end time of the time span and then use it whenever
you open a file or download data from the MicroLogPRO.
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To set the default zoom:

a. Click Graph Properties
then click Set Default Zoom.
b. Enter the start and end times, then click Set.

on the graph toolbar,

To zoom to the default zoom:

a. Click Graph Properties on the graph toolbar.
b. Select the Use default zoom check box and click
OK.
Every file and every data recording you download will
automatically open in the default zoom as long as the Use
default zoom check box remains selected.
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—

1%

To restore auto scaling, click Autoscale

Cropping the Data

Cropping enables you to trim the edges of a data set. Use it
to remove unwanted data:

1. Zoom to the data range you want to keep.

2. Click Offline Graph on the main menu, then click Crop.
All data outside the zoomed area will be permanently
removed.

Formatting the Graph

You can change a data line’s color, style or width. You can
also add markers that represent the data points on the graph
and format their style and color.
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The Y-axis color matches the corresponding plot’s color and
will change accordingly.
The time axis color can be changed separately as follows:

1. Click Graph Properties on the graph toolbar to
open the Graph Properties dialog box.

2. Select the Lines tab, then select the plot or axis you
want to format in the Select plot drop-down menu.

3. Here you can format the line’s color, style and width, as
well as the markers’ color and style. To remove the line
or the marker, unselect the corresponding Visible check
box.

To restore the default formatting, click the Restore

default button, and click OK.
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Copying the Graph as a Picture

You can copy the graph to the clipboard as a picture and
then paste it into other Windows programs, such as Word
and PowerPoint.

1. On the Offline Graph menu, click Copy graph.

2. Open the destination file.

3. Inthe destination file, right-click and select paste.

2.4.5. Exporting Data to Excel

Click Export to Excel on the main toolbar to export
the currently displayed data to an Excel spreadsheet.
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MicroLab Plus will open a new Excel workbook displaying
the data along with the MicroLogPRO info, including the
MicroLogPRO name, serial number and alarm levels setup.

Export File Settings

If MicroLab Plus fails to export the data properly i.e. all of the

data is displayed in one row of the worksheet, you can

change the export file settings. This ensures that the data is

exported using comma separated values (CSV).

1. Click File on the main menu, then click Export file
settings,

2. Select the Ignore regional settings check box.

3. Click OK.
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2.5. Programming MicroLogPRO

2.51. Setup

Use the Setup dialog box to view or change the
MicroLogPRO and Cradle settings.

Note: When setting up multiple Cradles, use the Auto Setup
tool (refer to page 169).

Note: To save the settings for future use, activate the Save
setup tool (refer to page 171).
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1. Connect the Cradle to the PC.

SETUP

2. Click Setup @M on the main toolbar to open the
Setup dialog box.

The dialog box consists of five sections:

e MicroLogPRO info

Comment
Click the text box and type a name that will serve to
identify the specific MicroLogPRO (e.g. its location).

S/N
Displays the MicroLogPRO’s serial number.
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Battery Level
If the indicator is in the red zone the battery should
be replaced (refer to page 24).

e Cradle info

Cradle ID
The cradle’s identification number sets the cradle’s
transmission time in daily download mode.

Battery Level
If the indicator is in the red zone the battery should
be replaced.

161



Chapter2  MicroLogPRO Plus .F

e Setup

Temperature
Select the Temperature check box to activate the
internal temperature sensor.

Humidity
Select the Humidity check box to activate the
internal humidity sensor.

External
Select the External check box to activate the
external sensor option, and then select a sensor in
the drop-down menu.

Cradle Contact
Select the Cradle contact check box to activate the
cradle contact.
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Note: The sensors’ current readings will appear next to the
sensor name once MicroLogPRO begins logging for the first
time.

Temperature unit
To set the temperature unit in the MicroLogPRO
display, select the option you want (Celsius or
Fahrenheit).

Interval
This determines the logging interval, or the time
interval between successive data recordings.
The time format is hh:mm:ss. Set the time setting to
select a recording time interval from 10 seconds to 2
hours. For example, to set a time interval of one
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hour, five minutes and thirty seconds, click the hours
(hh) and type 1 or use the arrows to select 01. Click
the minutes (mm) and type 5 or use the arrows, and
finally, click the seconds (ss) and type 30 or select
30 using the arrows.

Timer run
Click the Timer run check box if you want
MicroLogPRO to start recording at a predetermined
time. This option is convenient if you are using
several MicroLogPROs at once and want them to all
begin logging at the same time.

Cyclic run
In Cyclic run mode, MicroLogPRO overwrites the
old measurements (starting with the oldest recorded
data) once the MicroLogPRO’s memory is full. Click
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the Cyclic run check box to operate in this mode.
Use this mode if you intend to operate the system
continuously.

If the check box is clear, MicroLogPRO will operate
in Normal run mode and will stop recording when
the memory is full.

Push to run

In Push to run mode, the MicroLogPRO will only
start recording data when you press either the left or
right logger button. It is convenient for when you
wish to start recording data soon (but not
immediately) following setup, or at an unspecified
time.
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e Alarm levels

Type in the desired minimum and maximum alarm levels. If
MicroLogPRO records a reading that exceeds either of these
levels, the software's alarm will sound. The MicroLogPRO'’s
LCD will start to flash and the cradle’s alarm will sound.

To stop the LCD display flashing, press either of its two
buttons. To stop the cradle alarm from sounding, press both
of the MicroLogPRO'’s buttons simultaneously.

The default alarm levels are the lower and upper ends of the
sensors. Click Cancel Alarm to restore the default levels.
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e Cradle time settings
Workday hours

Use the up and down arrow buttons to set the daily
period when you want the Alarm and/or the Daily
Download to be active, or enter the desired period
manually for when you want them to all begin
logging at the same time.

Alarm delay
Use the drop-down menu list to select the time delay
between the time MicroLogPRO records a reading
that exceeds the alarm levels and the time the alarm
will sound.

Alarm duration
Use the drop-down menu to select the time for which
the alarm will operate before it stops automatically.
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Completing the Setup

Click Send Setup to send the new settings to MicroLogPRO,
which will complete the setup. Click Cancel if you do not
wish to change the setup at this stage.

Note: The Send Setup command erases all existing data in
the MicroLogPRO, and it will automatically begin recording.

If you select Timer run mode, MicroLogPRO will wait in

standby mode, displaying . It will begin recording at the
specified time.
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2.5.2. Auto Setup

When setting-up multiple cradles, use the Auto Setup tool.

This tool will automatically set the minimum logging interval,

depending on the number of units you are using, and will set

the start time for each unit.

To perform Auto Setup:

1. Connect the first cradle to the PC.

2. Click Logger on the main menu, then click Auto Setup.

3. In the Number of units drop-down menu, select the
number of cradles you are setting up, then click Start.

4. Set up the first unit as you would normally.

Note: The minimum logging interval is already set in the
Interval menu. You may not select a shorter time interval.
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5. Click OK.

6. Click Send.

After setup is completed, the Auto Setup tool is ready to
setup the second unit (note that the title bar on the Auto
Setup dialog has changed to Unit 2).

7. Connect another cradle to the PC.

8. Change the Comment (optional).

9. Click Send.

10. Repeat this procedure with every cradle.

To change the settings of a specific unit, click Edit in the
Auto Setup dialog and select the new settings before
executing the Send command. These settings will be saved
until the next time you change them.
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Use the forward and backward arrow buttons on the Auto
Setup dialog to navigate to a specific unit. Note that this will
change the automatic sequence.

2.5.3. Saving Setup

When setting up multiple cradles, use the Save Setup option

in the Setup dialog.

1. Once you have finished the settings selection of the first
cradle, and before sending the setup command, click
Save Setup. This will save all of the setup settings.

SETUP

s

2. Connect another cradle to the PC, click Setup @W
on the main toolbar, then click Load Setup to load your
setup settings.
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3. Change the Cradle ID.
4. Change the Comment (optional).
5. Click Send Setup.

2.5.4. Defining a Custom Sensor

You can use MicroLogPRO with any sensor that has a 0 —

20mA current output or a 0 — 10V voltage output.

1. Click the Logger menu and then select Define New
Sensors to open the Define New Sensor dialog box.

2. Click Add to add a new sensor to the list.

3. In the Based On drop-down menu, select an external
sensor that matches your sensor’s output.

4. Enter the sensor's name in the Sensor Name text box.

5. Enter the sensor’s unit in the Sensor Unit text box.
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In the Calibration Values section, enter two values of
your sensor that correspond to the base sensor values.
For example, see the definition for a 0 — 100mbar
pressure sensor whose output is 0 — 20mA:

X

6.

Define New Sensor

Based on

Et. Current = SensorName:  [Prassure
SensorUnit:  [mb

Calibration Yalues
Base New
Sensor Sensor

vaue [0 o
Valuz #2: |20 100

Add Remave
oK Cancel

Figure 13: Defining a new sensor
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7. Click OK.
The new sensor will then appear in the External Sensor list
in the Setup dialog box.

2.5.5. Sensor Calibration

A new MicroLogPRO comes fully calibrated. After a long
period of use, however, you may want to recalibrate the
humidity or temperature sensors.

The calibration affects both MicroLogPRO and MicroLab
Plus and should be carried out while MicroLogPRO is
connected to the PC.
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Calibration Password

To

prevent accidental change of the calibration, the

calibration procedure is protected by a password. The default
password is: 1234. To change the password:

1.

2.

3.

Click Logger on the menu toolbar, then click
Calibration.

Click Change Password to open the Change
Password dialog box.

Enter the current password in the Current Password
text box.

Enter the new password in the New Password text box.
Enter the new password a second time in the Confirm
New Password text box to confirm your new password.
Click OK.
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Note: The password must include at least 4 characters and
is case sensitive.

Humidity Calibration

To calibrate the humidity sensor you will need a humidity

chamber.

1. Connect the MicroLogPRO to the PC.

2. Set up the MicroLogPRO to record every 10 seconds
(refer to page 159).

3. Click Logger on the main menu, then click Calibration.

4. Enter the calibration password, then click OK.

5. Select Humidity in the Choose sensor drop-down
menu.
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Calibration El

Chuoose sensor :

Calibration Yalues

Reference Microlog
walue value

First walue 3300 0

Second value 76.00 il
Default Calibrate

Close

Figure 14: Humidity calibration dialog box
6. Click Default to restore the original values.
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7. Disconnect MicroLogPRO from the PC and insert it into
the humidity chamber.

8. Set the humidity chamber to the first reference value.
Wait until the humidity level is stabilized and write down
the MicroLogPRO’s reading.

9. Repeat the last step with the second reference value.

10. Connect the MicroLogPRO to the PC.

11. Enter the two MicroLogPRO values into the
MicroLogPRO Value text boxes.

12. Enter the two reference values into the Reference Value
text boxes.

13. Click Calibrate.

To restore default calibration, click Default.
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Temperature Calibration

1.

2.
3.
4

oo

7.

8.

Connect the MicroLogPRO to the PC.

Click Logger on the main menu, then click Calibration.
Enter the calibration password, then click OK.

Select Temperature or Ext. Temperature in the
Choose sensor drop-down menu.

Click Default to restore the original values.

Enter the two MicroLogPRO values into the
MicroLogPRO Value text boxes.

Enter the two reference values into the Reference Value
text boxes.

Click Calibrate.

To restore default calibration, click Default.
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2.,5.6. Setting IR Printing Format

1. Connect the MicroLogPRO to the PC.

2. Click Logger on the menu toolbar, then click
MicroLogPRO IR Print Settings:

IR print settings dialog

& Frint format 1
" Print format 2

Figure 15: IR Print Settings dialog box
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3. Select a format option:

a. Print Format 1 — Prints the minimum and
maximum values of a selected time period up
to the last 30 days.

b. Print Format 2 — Prints all data up to 128 rows
of data

4. If you selected Print Format 2, enter the desired number
of rows (up to 128).
5. Click OK.

2.5.7. Communication Setup

Communication between a PC and a MicroLogPRO takes
place automatically whenever you send a command to
MicroLogPRO. However, the Communication Setup dialog
box can be used for more advanced communication options.
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Click on the Logger menu and then select Com setup to

open the Communication Setup dialog box:

Select Port :

COMT
COM3

Tr_utncnnnect Py —— | el |

Figure 16: Communication setup dialog box

The selected COM ports are available for communication.
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1. Click Try to connect to establish communication.
2. Click Work offline to work with saved files.
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2.6. Analysis Tools

2.6.1. Setting the Analysis Tools Parameters

1 . Cl |Ck Functions’ Parameters Dialog 3]

An alys | S on MKT (Mean Kinetic Temperature)

et m
the menu bar, i ——
then click Set T —
F u n Cti on s ’ Fo Pasteurization
Parameters P o
to open a oo At o
dialog box: ol |

Figure 17: Functions Parameters
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2. Type in the desired parameters, then click OK.

2.6.2. Histogram

Use this tool to create a frequency distribution of the selected

data set.

To create a histogram:

1. Use the cursor to select a plot on the graph.

2. Click Analysis on the main menu bar, then click
Histogram.

3. Enter the desired values for the first bin, the bin width
and last bin, then click OK (refer to the tip below for
details).

4. Click Analysis on the main menu, then click Histogram
a second time to return to the original data sets
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Tip: You can modify the histogram to your needs. You
can set the upper limits of the first bin and the lower
limit of the last bins, and refine the histogram by
increasing the number of bins.

To modify the histogram:
1. Click Analysis on the main menu, then click Histogram

properties:
Fitst i s
Bin width: o
Last bin [ss
ol

Figure 18: Histogram settings
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2. Enter the desired values for the first bin, the bin width
and last bin, then click OK.
You can repeat the process for further modification.

2.6.3. Pasteurization

Use this tool to create and display an FO Pasteurization
curve:

Click Analysis on the menu bar, then click FO
pasteurization.

2.6.4. Statistics

Use the statistics tool to display statistics of each data set in
the graph. The statistics include:

Minimum — The smallest value in the data set

Maximum — The largest value in the data set
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Average — The average of all the numbers in the data set
MKT — The mean kinetic temperature (for temperature data
only)

To display statistics:

Click Statistics )3

MicroLab will display the statistics in the information bar at
the bottom of the graph window.

on the main toolbar.

>

To hide the statistics, click Statistics a second time.
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2.7. Toolbar Buttons

2.71. Main (Upper) Toolbar

Open Opens saved files (enabled only in
i Offline View)
= Print... Opens the Print Option dialog box
: ;l (enabled only in Offline View)

Export Exports the displayed data to an
Excel spreadsheet (enabled only
in
Offline View)
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SETUP

g

Setup

°C/°F

Meters View

Multiple
Graphs View

MicroLogPRO Plus -I:

Opens the Setup dialog box
Displays the desired temperature
unit

Displays the Meters View

Displays the Multiple graphs View
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Offline View  Displays the Offline View
Cradle Map Displays the Cradle Map

Scroll back Scrolls to the previous
MicroLogPRO units display
(enabled only in Online View)

Auto-scroll Automatic  scrolling  between

MicroLogPRO unit displays
(enabled only in Online View)
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Scroll forward Scrolls to the next MicroLogPRO
* units display (enabled only in

Online View)

\9 Alarm Enables or disables sound alarm

2.7.2. Graph (Lower) Toolbar

Q| Zoom in Activates the zoom tool
g/* “| Pan Activates the pan tool
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— | Auto scale Returns the graph to full view
Cursor Toggles the cursor

Second Toggles the second cursor
cursor

Graph Opens the Graph Properties dialog
properties box (only in Offline view)

& Alarm levels  Displays or removes alarm levels
from the graph
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|Externa| j Alarm level selection box

2.7.3. Cradle Map (Lower) Toolbar

In Cradle Map view, click Cradle Map on the main menu,
then click Display toolbar to display the Cradle Map toolbar.

Lock Locks or unlocks the Cradle Map
+@ Add Cradle Adds a Cradle icon to the Cradle
Map

_@ Remove Cradle  Removes a Cradle icon from the
Cradle Map
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Load image Inserts an image to the Cradle
Map
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Chapter 3 The Cradle
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3.1. MicroLogPRO Cradle Line

3.1.1. Alarm Cradle

This cradle accommodates an additional external sensor and
RS 232/USB Computer Serial Interface, and a hardware
alarm that operates the sound alarm.

Catalog number: DT174

3.1.2. Wireless Cradle with Alarm

A wireless cradle that transmits data to the PC. It
accommodates an additional external sensor and
RS 232/USB Computer Serial Interface, and a hardware
alarm that operates the sound alarm.
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Catalog number: DT175

198



i’. The Cradle Chapter 3

3.2. Operating the Cradle

1. Mount the
MicroLogPRO on the
cradle so that its rear
connection socket
fits into the plug on
the cradle.

3. External
sensor input

/

2b. USB socket Trs
<4 button
4. DC power input
i LED
2a. R82§2 s.erlal indicator
communication . -
socket Figure 19: MicroLogPRO and Cradle
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To set up MicroLogPRO (see Figure 19 above):

1. Mount the MicroLogPRO onto the cradle (1).
Connect the cradle to the PC using either a serial or
USB communication cable (2).

3. Run the MicroLogPRO software and use the Setup
command.

To prepare the wireless cradle to transmit data:

1. Set up the MicroLogPRO (see Figure 19 above).

2. Connect an external sensor if needed (see 3 in Figure 19
above).

The cradle will automatically transmit data online or once a

day depending on how it was set up.

Refer to page 99 for more on online transmission or page 81

for more on Daily Download.
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When the cradle transmits data the LED indicator lights up
green.

To manually transmit data to the PC:

Press the Trs (Transmit) button on the right side of the
cradle. The cradle will then transmit all stored data to the PC.

To activate the Sound Alarm feature:

You must connect the AC power adaptor (see 4 in Figure 19
above).
When the alarm operates, the LED indicator lights up red.
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3.3. Replacing the Battery

The cradle is powered by an internal battery or by an
external AC adaptor. The cradle battery’s maximum lifespan
is approximately 100,000 transmissions (for example, if the
recording rate is once every 15 minutes, then the battery’s
lifespan is approximately 3 years.

The cradle uses a 1/2AA 3.6V lithium battery

1. Unfasten the four screws at the back of the cradle.
. Carefully rotate the cradle.

3. Remove the front cover and replace the battery. Be sure
to insert the new battery in the correct corresponding
polarities (look for the “+ symbol next to the positive
terminal).
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4. Replace the front cover, turn the cradle over and
refasten the four screws at the back of the cradle.

3.4. Screw Terminals

The cradle is equipped with eight screw terminals for
permanent connections to the cradle. These terminals
include:

Connection to external sensor: Identical to the cradle’s
external sensor socket.

Contact sensor (DT175 only): This cradle sensor (in
addition to the usual external contact sensor) monitors Reed
Relay contacts and switch status (open/closed) to identify the
correlation between phenomena such as temperature
change and door status. This sensor’s data is stored in the
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cradle’s memory and is available only through wireless
transmission.

External control switch: Closes an external control circuit
when sensor readings exceed alarm levels. Maximum load:
30VDC, 1A.
Alarm device/Relay
AL-Hor/and AL-L

To Cradle screw terminals To DC power source

[ >

GND -vVDC

Figure 20: External control switch wiring
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You can wire one alarm device for High alarm level (AL — H
terminal) and another alarm device for the low alarm level
(AL — L terminal), or you can connect the same device to
both terminals so it will operate whenever any of the alarm
levels are exceeded.

If you want to operate an alarm device that consumes more
than 30VDC, 1A or an AC alarm device, you will have to use
a relay.

External power: Connection to an external 12VDC power
supply (i.e. vehicle battery).
To connect to the screw terminals:

1. Unfasten the antenna screw at the top back of the
cradle.
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2. Remove the antenna.

3. Unfasten the four screws at the back of the cradle.

4. Remove the back cover and break the oval seal at the

bottom of the back cover by pressing it with a

screwdriver.

Replace the back cover.

Carefully rotate the cradle.

Remove the front cover.

Insert the external wires through the oval opening you

have broken at the back cover and fasten them to the

appropriate screw terminals (refer to Figure 21 and the

table below).

9. Replace the front cover, turn the cradle over and
refasten the four screws at the back of the cradle.

10. Replace the antenna and fasten the antenna screw.

®NoO
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!
U 7 “‘1.3 i.-,.r'l

Figure 21: Cradle’s screw terminals

The table below lists the various screw terminals according
to their labels (from left to right) that are printed above the
terminals.
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The Cradle -I:

Function

AN
PWR

DOOR
GND

AL-H
AL-L

GND
+12V

o~N OO0 AW N
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Contact sensor (online only)

External control switch (30VDC, 1A)

External power
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Chapter4 The Receiver
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4.1. Overview

The Receiver is designed to receive wireless data from
remote MicroLog cradles or Repeaters and send it to your
computer.

The Receiver is equipped with two LED indicators to show
Receiver status and is powered by an AC/DC mains adaptor.

4.2. Getting Started

4.21. Locating the Receiver

Locate the Receiver near the computer. You can either place
it on a tabletop or hang it on the wall.
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4.2.2. Receiver Layout

v Antenna

Data LED

Indicator RF LED
Indicator

USBsocket 4 9-12V

Serial socket DC Input

Figure 22: Receiver layout
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4.2.3. Powering the Receiver

The receiver must be connected to the mains when in use.
The rechargeable battery functions only as a backup in the
event of electricity failure.

Connect the supplied AC/DC adaptor to the mains, and then
connect it to the 9-12V DC input at the bottom of the
Receiver (refer to Figure 22 above).

The Receiver is now ready to receive data and transfer it to
the computer.

4.2.4. Connecting the Antenna

Screw the supplied whip antenna to the SMA antenna socket
at the top of the Receiver (refer to Figure 22 above). If the
Receiver is lying on a tabletop, use the hinge to bend the
antenna to an upright position.
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Note: You can also use Fourier Systems’ magnet antenna
(refer to Chapter 5).

4.3. LED Indicators

Two LED indicators are used to indicate the Receiver's
status by flashing. The indicators are located on the
Receiver’s front panel. The upper LED is marked DATA and
the lower LED is marked RF.

The RF indicator lights up red whenever the Receiver
receives RF carrier of the operating frequency (433MHz in
Europe or 915MHz in the US).

The DATA indicator lights up green whenever the Receiver
receives MicroLogPRO data.
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The upper LED also represents the power supply and lights
up yellow whenever the Receiver is connected.

If the Receiver is disconnected from the mains power supply,
the DATA indicator lights up yellow and keeps blinking every
two seconds as long as the external power is down. The
backup battery will allow for five hours of operating.
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4.4. Beeper

The Receiver is equipped with a built-in beeper that beeps
whenever the Receiver receives a single data point. If the
Receiver receives daily download data, it beeps when
transmitting it to the next leg.

To turn the beeper on and off:

1. Connect the Receiver to the computer.

2. Run MicroLab or MicroLab Plus software.

3. Click Logger on the main menu, then click Receiver
beeper on.

4. To change the beeper’s status, repeat step 3 above.
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Chapter 5 External Magnet Antenna

For use with the Cradle and/or Receiver
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5.1. Overview

The external antenna is equipped with a magnet clamp for

easy mounting on metallic surfaces. Just plug the antenna to

the Cradle or Receiver, place the magnet antennae in a

location where transmission is most accessible (for example,

on the roof of a truck) and you are ready to go.

Use the external antenna in cases where the:

e Cradle or Receiver is located in metal chambers (for
example, in refrigerators).

e Cradle or Receiver is located indoors for protection from
harsh environmental conditions and rain.

217



Chapter 5 External Magnet Antenna -I:

The external antenna is designed for 914MHz and 433MHz
carriers. The antenna adds a 1-3dB gain to the Transmitter-
Receiver path. With the use of an external antenna on both
Cradle and Receiver we manage to maintain a constant data
reception from the Cradle at distances of 360m with no line
of sight.
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5.2. Connecting the Antenna to the
Receiver

To use the external antenna, simply screw the antenna to the
SMA connector at the top of the receiver (refer to Figure 22
on page 211).

5.3. Connecting the Antenna to the
Cradle

All cradles produced after March 2003 have an SMA
connector on their right side of the cradle.

To use the external antenna, simply screw the antenna to the
SMA connector.
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SMA external

/ antenna

Figure 23: MicroLog PRO with Cradle
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5.4. Preparing the Cradle to work
with the External Antenna

The cradle is equipped with an internal jumper that connects
the transmitter either to the built-in wipe antenna or to the
external magnet antenna.

To change the jumper position:

1. Unfasten the four screws at the back of the cradle.

2. Carefully rotate the cradle.

3. Remove the front cover.

4. Place the jumper in the desired position.
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Figure 24: Changing the jumper position
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The jumper connects the middle pin either to the right-hand
pin marked INT (internal antenna) or to the left-hand pin

marked EXT (external antenna).

Figure 25: INT and EXT Antenna pins
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5. Replace the front cover, turn the cradle over and
refasten the four screws at the back of the cradle.
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Chapter 6 External Sensors
MicroLogPRO works with the following external sensors:

6.1. Temperature -50°C to 110°C
(Thermistor-based)

Takes external temperature measurements over a wider
range than the internal temperature sensor and with a faster
response time.

Specifications:

Range: -50 °Cto 110 °C
Resolution: Better than 0.3 °C between -30 °C to 90 °C
Accuracy: 1 °C (before calibration)

225



Specifications .I:

Probe Length: 100 mm
Probe OD: 3.2 mm
Probe Max. Temperature: 150 °C
Cable Max. Temperature: 80 °C

6.2. Temperature PT100 Adaptor

Offers a smaller temperature range with a higher accuracy.

Range: -10°Cto 10 °C
Resolution: 0.06 °C
Accuracy: 0.12°C +/-0.12°C

Trimmer calibration is possible
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6.3. Voltage Sensor

Measures any device or transmitter that produces a linear
analog output of 0-10V. The voltage can easily be converted
to the correct measured units with the help of the MicroLab
and MicroLab Plus software.

Specifications:

Range: 0to 10V
Resolution: 0.01v
Accuracy: 1% from reading +/- 0.02V

Input Impedance: 25kQ
OV Protection: 30V

227



Specifications .I:

6.4. Current Sensor

Samples any device or transmitter producing a linear current
of 0-20mA. The 0-20mA can be converted to the correct
measured units using the MicroLab software’s Calibration
option.

Specifications:

Range: 0 to 20mA
Resolution: 0.02mA
Accuracy: 1% from reading +/- 0.006mA

Input Impedance: 166 Q
OV Protection:  100mA
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6.5. pH Sensor

Monitors the pH level of liquids.
Specifications:

Range: 1to 14 pH
Resolution: 0.03 pH
Accuracy: 3% of reading

6.6. Conductivity
Monitors conductivity of liquids.
Specifications:

Range: 31020 mS
Resolution: 0.04 mS
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Accuracy: 3%

6.7. Contact Adapter

Monitors Reed Relay contacts and switch status
(open/closed) to identify the correlation between
phenomena, such as temperature change and door status.

Specifications:

Range: Open/Close
Connector: Screw Terminal
Cable Length: 2.5m

Internal Pull-Up Resistor: No need for an external power
source
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Specifications

MicroLogPRO
Models:

EC700: Temperature and external sensor data logger

EC750: Temperature, relative humidity and external
sensor data logger

Inputs:

Two built-in sensors:

Temperature
Range: -40°Cto 80 °C
Resolution: 0.2°C (-40 'Cto0 -20 °C)
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0.1°C (-21°Cto 50 °C)
0.2°C (51°Cto0 80 °C)
Accuracy (all ranges): 0.2 °C

Response time: ~ 15 minutes
Software calibration is possible

Relative Humidity:
Range: 0 to 100%
Resolution: 0.1%
Accuracy: 3%
Response time: ~ 25 minutes

Software calibration is possible
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External Sensors:

Refer to Chapter 6.
Outputs:
Four digit 7-segment LCD with decimal point
Wireless rapport to infrared HP printer HP82240B
RS232 serial communication at 19,200 bps
USB 1.1 (optional — low water and dust protection)
Memory Capacity:
1 sensor 52,000 samples
2 sensors 26,000 samples
3 sensors 16,000 samples
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LCD Unit Icons:
°C, °F, %RH, pH, V, mA, mS, AL-H, AL-L
Power Supply:

Internal Lithium Battery: 3.6V, 1.2AH, 1/2AA

Battery Life: Approximately two years. May vary with
number of sensors connected and the sampling rate
settings (for more details refer to page 22).

Sampling Rate:

User defined: From once every 10 seconds to once
every 2 hours
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Dimensions:

Diameter:  72mm
Thickness: 22.9mm
Weight: 55¢g
Standards:
Water and dust proof IP65 standard compliance
CE and FCC standard compliance
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MicroLogPRO Cradle
Models:

DT174:

Additional external sensor
RS 232/USB Serial Interface
Audible alarm

DT175:

Wireless data transmission
Additional external sensor
RS 232/USB Serial Interface
Audible alarm
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Serial Communication Channels:

RS232 at 19.2Kbps
USB at 1.5Mbps
Memory Capacity (DT175 only):

2,000 recording samples
Connectors:

4-pin flat connection to the MicroLogPRO
4-pin flat connection to any MicroLogPRO external
sensor

Screw terminal for external DC supply, connection to
external sensor, external control switch and additional
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Contact sensor (the additional contact sensor is
available in DT175 only)

Power Supply:

Internal: Lithium battery, 3.6V

Battery Life: Approximately 100,000 transmissions,
replaceable

External: 6-30V, minimum 300mA
RF Transmission (DT175 only):

EMC conformant to ETS 300-683

Type approved to ETS 300-220. Usable range to 300m
(75m indoors) 418 (UK) & 433.92MHz (Euro) versions

1mW on 418 MHz, 10mW on 433.92MHz
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2nd harmonic <-60dBc
16cm wipe antenna
CE and FCC standard compliance
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Specifications

MicroLab Plus Receiver
Communication Ports:
RS232 at 19.2Kbps

USB at 1.5Mbps
Power Supply:

External: 9-12VDC, minimum 300mA

Red LED indicating RF signal

Green LED indicating valid data being received
RF Receiver:
European version

Frequency: 433.92MHz
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Type approved to ETS 300-220

Usable range: To 300m (75m indoors)
North American version

Frequency: 914.5MHz

Usable range: To 120m (30m indoors)
Antenna:

SMA connector

Supplied with rubber whip antenna (with a hinge)
Dimensions:

10x9%x2.5 cm
CE and FCC standard compliance
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Software
MicroLab Software Features

242

Runs on WINDOWS 98/2000/ME/XP and NT

Fast data download from the MicroLogPRO

Graphic visualization of the MicroLogPRO data
Data displayed in graphs and tables

Data export to EXCEL

Graphic analysis tools such as Markers, Zoom
MicroLogPRO Setup windows, for setting up the
MicroLogPRO unit ID, sample rate, sensors and
alarm level

Sampling rate: Once every 10 seconds to 2 hours
Definition of additional external sensors
MicroLogPRO sensor calibration
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Display of MicroLogPRO Battery Level

Integration with the wireless MicroLogPRO Cradle,
Receiver and Repeater

Display of daily reports of a fleet of data loggers
Visual alarm levels on the graph and table

MicroLab System Requirements

Software
Windows 98 or later
Internet Explorer 4.0 or later (Internet Explorer 5
can be installed together with MicroLab, as it ships
with the product)

Hardware
Pentium 300MHz or higher
32 MB RAM (64 MB recommended)
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5MB available disk space for the MicroLab
application

MicroLab Plus Software Features

244

Wireless communication with up to 200
MicroLogPROs

Real-time temperature and humidity and external
sensor readings

Data display in meters or graphs

Visual and sound alarm when the data reading
exceeds a minimum or maximum alarm threshold
for temperature or humidity

E-mail alarm notification

Battery level display
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Automatic data saving to an Excel file
Data Map allowing the users to easily view many
MicroLogPRO data loggers on one screen
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MicroLogPRO Setup windows, for setting up the
MicroLogPRO unit ID, sample rate, sensors and
alarm level

Sampling rate: Once every 10 seconds to 2 hours
Definition of additional external sensors

MicroLab Plus System Requirements

Software
Windows 98 or later
Internet Explorer 4.0 or later (Internet Explorer 5
can be installed together with MicroLab, as it ships
with the product)
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Hardware
Pentium 300MHz or higher
32 MB RAM (64 MB recommended)
5MB available disk space for the MicroLab Plus
application
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